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WARRANTY 

 

First Year Warranty 

The Gentec-EO thermal power and energy detectors carry a one-year warranty (from date of shipment) 
against material and /or workmanship defects when used under normal operating conditions.  The 
warranty does not cover recalibration or damages related to misuse.   
 
Gentec-EO will repair or replace at its option any wattmeter or joulemeter which proves to be defective 
during the warranty period, except in the case of product misuse.   
 
Any unauthorized alteration or repair of the product is also not covered by the warranty.   
 
The manufacturer is not liable for consequential damages of any kind.   
 
In the case of a malfunction, contact the local Gentec-EO distributor or nearest Gentec-EO office to obtain 
a return authorization number.  Return the material to the address below.  

 

All customers: 

Gentec-EO, Inc. 
445 St-Jean-Baptiste, Suite 160 
Quebec, QC, G2E 5N7 
Canada 

Tel: (418) 651-8003 
Fax:  (418) 651-1174 
Email:  service@gentec-eo.com 
Web:  www.gentec-eo.com 

 

 

Lifetime Warranty 

Gentec-EO will warranty any thermal power and energy detector head for its lifetime as long as it has 
been returned for recalibration annually from the date of shipment.  This warranty includes parts and labor 
for all routine repairs including normal wear under normal operating conditions.   
 
Gentec-EO will inspect and repair the detector during the annual recalibration.  Exceptions to repair at 
other times will be at Gentec-EO’s option.  
 
Not included is the cost of annual recalibration or consequential damages from using the detector.   
 
The only condition is that the detector head must not have been subject to unauthorized service or 
damaged by misuse.  Misuse would include, but is not limited to; laser exposure outside Gentec-EO’s 
published specifications, physical damage due to improper handling, and exposure to hostile 
environments.  Hostile environments would include, but are not limited to excessive temperature, 
vibration, humidity (>80%), or surface contaminants; exposure to flame, solvents or water; and connection 
to improper electrical voltage.  
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1 GENERAL INFORMATION 

 
 

1.1 System Overview 

 
Welcome to the T-Rad-USB Application Software. This software, when coupled with a Gentec-EO 
T-Rad-USB, provides the user with a versatile measurement system. There are multiple sensors 
available for the system. When a sensor is mated to the USB module, the module reads the 
sensor type, sensor calibration, sensor wavelength response, and configures the hardware 
appropriately. When the Application software is started it queries the T-Rad-USB and configures 
itself for the appropriate measurement system. For this reason the application software will not 
always show all control and indicators, i.e., it will not have Trigger controls and indicators for an 
Optical Power Meter. 
 
The Applications Software communicates with the host PC via a USB port. The system uses the 
T-Rad-USB Command Set to do this. 
 
Data is sent to the host PC when the instrument has had its data gate turned on. The sampled 
data is sent to the application at 1 kHz. The Lock In algorithm is implemented in the application. 

 

2 Lock In Amplifier Theory of Operation 
 
The operation of a Lock In Amplifier can seem mysterious given its ability to pull a useful signal 
out of noise and interference, but the basics of operation are not complex. A lock in amplifier's 
operation can be explained in three ways: mathematically, in the time domain, or in the frequency 
domain. While all explanations are equally useful, the one that makes sense to the user is the 
most useful, so a brief description of all three will be presented. 
 

2.1 Mathematical Description of a Lock In Amplifier. 
 
Fourier Theory tells us that all repetitive signals can be broken down into a series of sine’s and 
cosines. Because of this fact, we can describe the lock in operation using a signal that is a pure 
cosine wave. To go further, even if the input signal is not a pure cosine wave, the lock will extract 
the pure cosine wave component of the signal anyway, so the approach is justified. Consider an 
input signal, v (t), given by: 

 

 
 
Now consider a second signal, the reference signal, given by: 

 

 
 
This reference signal is at the same frequency as the input signal and is supplied by thelock in. 
 
If we multiply the two signals, we get 



T-RAD-LEMO-USB Instruction Manual                            Version 2.0                June 2012 6 

 
 
If we set B to unity and hold it constant, then the result is a signal that is: 
 
1. Proportional to the A, the amplitude of the input signal. 
2. Proportional to the cosine of the phase angle between the two signals. 
3. Modulated at two times the input signal frequency. 
 
If we set the phase difference to zero degrees then the resulting signal can be passed through a 
low pass filter with a time constant of tau and the result will be: 
 

 
 
This shows that once the filter has settled, the signal is a DC representation of the original input. We can 
now set the filter time constant as high as needed to block out unwanted noise and interference. The 
details of how the lock in implements this math can be found in the literature. 
 
One subject of interest arises from the requirement to set the phase difference to zero degrees. In 
practice, the phase difference is not known. Since the cosine function returns values between one and 
negative one as the phase is changed, the phase is simply adjusted until the signal maximizes. It is 
actually easier to adjust the phase until the signal goes to zero and then shift the phase by 90 degrees. If 
the signal goes negative, shift the phase 180 degrees. The signal will now be maximized. 
 
If this seems like a bother, it is. The Gentec-EO Lock In Amplifier uses a dual phase approach which 
relieves the user of the need to adjust the phase. A sine wave signal is generated by the instrument at the 
reference frequency, and at the reference frequency plus 90 degrees, or pi divided by 2. The input signal 
is multiplied by both reference signals. The results of those multiplications are then squared, summed, 
and the square root is taken. Look at the final equation for the output after the multiplication, ignoring the 
second term: 

 

 
 
The output of the second multiplication will be: 

 

 
 
 



T-RAD-LEMO-USB  Instruction Manual                 Version 1.0         June. 2012 7 

If we square these and add them together we obtain: 

 

 
 
Now taking the square root gives: 

 

 
 
The output of the multiplication is no longer phase dependant. 
 

2.2 Time Domain Description of a Lock In Amplifier. 
 
The input signal has peak amplitude of 5V (10V peak to peak) and a frequency of 25Hz and is 
shown in figure 1. 

 

 
Figure 1  Input Signal 
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The reference signal supplied by the lock in signal has peak amplitude of 1V and a frequency of 
25Hz and is shown in figure 2. 

 

 
Figure 2  Reference Signal 

 
After multiplying the two signals using a circuit called a Phase Specific Detector in ananalog lock in, or by 
direct math in a digital lock in, the output signal is shown in figure3. Note that its peak to peak amplitude is 
5V, or ½ of the input and its frequency is 50Hz,or twice the input frequency. Also note it now has a DC 
offset of the peak voltage of the input signal divided by 2 as predicted. This DC offset is what the low pass 
filter will pull from figure 3. 

 

 
Figure 3  Result of Multiplication 
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Figure 4 shows the output using a 100ms time constant. Note that the ripple is still visible on the DC level. 

 

 
Figure 4  Output with 100ms Time Constant 

 
Figure 5 shows the output using a 1s time constant. Note that the ripple is greatly 
reduced. 

 

 
Figure 5, Output with 1s Time Constant 
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2.3 Frequency Domain Description of a Lock In Amplifier. 
 
Figure 6 shows the frequency contents of a 25Hz square wave with a 60Hz interference signal 
and broadband noise at about 1% of the signal. 

 

 
Figure 6   Corrupted Input Signal 

 
Since the input is a square wave, there are only odd harmonics. The fundamental is seen at 
25Hz, the 3rd harmonic is seen at 75Hz, and the 60Hz interference is seen. Remember when we 
said that even if the input signal is not a pure sine wave, the lock will extract the pure sine wave 
component of the signal? Figure 6 shows why this is so. The reference signal is a pure sine wave 
at the same frequency as the input signal so only the fundamental sine wave component of the 
input signal is extracted. Of course this statement depends on the purity of the reference sine 
wave. In an analog system, a pure sine wave cannot be generated due to distortion and phase 
noise as well as frequency jitter. All of these combine to decrease the accuracy of the instrument. 
Since the Gentec-EO Lock In Amplifier is a digital device, the reference sine wave is pure to a 
much greater extent and these errors are minimized. 
 
Figure 7 shows the spectrum of the signal after it has been passed through a band pass filter set 
to 25Hz. 
 

 
Figure 7  Band Pass Filtered Corrupted Input Signal 
 
Note that the relative amplitude of the 60Hz and 75Hz signals have been reduced by the 
band pass filter. The noise floor has also taken on the shape of the filter. Figure 8 shows 
the spectrum of the multiplied signal. 
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Figure 8  Phase Specific Detector Output Signal 
 
The multiplier action moves the signal to the frequencies at the sum and difference of the signal 
and the reference frequency at 25Hz. Therefore the signal at 25Hz will move to 0Hz and 50Hz, as 
seen. The 60Hz interference will move to 85Hz and -35Hz, not shown here. The odd harmonic of 
the input signal at 75Hz moved to 100Hz and 50Hz, where it will add to the frequency shifted 
signal. These signals can now be low pass filtered to extract the DC component. 
 
 

3 Communications with Host PC 
 
The T-Rad-USB communicates with the host PC via a USB port. The device supports full speed 
USB 2.0. The implementation of the port in the host PC is accomplished via a Virtual Com Port, 
or VCP. This in effect mimics a standard com port so that the user can take advantage of the 
ease of developing custom applications with existing terminal emulators. 
 
The Ports Settings are: 
 
Baud Rate : 921600 
Data Bits : 8 
Stop Bits : 1 
Parity : None 
Flow Control : None 
 
The host PC must have a terminal emulator as well as the T-Rad-USB USB drivers installed. These 
drivers are installed by the disc supplied with the T-Rad-USB instrument. 
 

4 Data Format 
 
Measurement Data is sent from the T-Rad-USB as an Hexadecimal string. 
 
The format is: DDDDCRLF 
 
Where DDDD is a 12 bit value representing the ADC counts and terminated by a carriage return 
followed by a line feed. The Lock in Amplifier algorithm is implemented in the Applications 
Software. 
 

5 Instrument Connections 
 
The T-Rad-USB is connected to the host PC with a supplied USB cable. The instrument 
communicates with the host PC via this cable, and the host PC supplies the power required by 
the instrument. 
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There are two BNC’s and one Lemo connector on the instrument. The probe in use is plugged 
into the Lemo connector and must be plugged in before connecting the USB cable. One BNC is 
labeled Detector Output, the other is labeled External Trigger In. 
 
The Detector Output BNC supplies a buffered signal that is the same value sampled by the 
instrument’s ADC. The output impedance of this connector is 100Ω. 
 
The External Trigger Input is the connection for the reference chopping frequency. This signal’s 
frequency is measured by the instrument and used to generate the reference sine wave 
described in the Theory of Operation section. This BNC should be connected to the Sync Output 
BNC of the chopper controller in use. 
 

6 Using the Instrument 
 
To use the T-Rad-USB, connect the probe to the instrument first, then plug the instrument into the 
USB connector on the PC that is running the Applications Software. Connect the chopper 
frequency reference to the External Trigger Input BNC. Now start the software. A window will 
appear, as shown below. 
 

 
 
Press the Proceed button. The software will examine the available communications ports and 
establish communications with the instrument. When the WAIT prompt disappears from the data 
display, the software and instrument are ready to use. The T-Rad-USB is not a triggered device. 
It is always taking data, but it will not send data to the application until asked to do so. Pressing 
the Data Collection Button causes data to be sent to the application where the lock in algorithm is 
implemented. The user need only select an appropriate range and filter time constant. 
 
The Frequency Range indicator will display the correct chop rate to use. If the range is 24.5 HZ to 
25.5HZ, set the chopper to 25Hz. The instrument will extract the signal at the reference 
frequency. Note that if there is any other signal with components at the reference frequency, they 
will be measure along with the desired signal. The longer the filter time constant, the longer it will 
take to settle on a reading, but the more noise and interference will be rejected. The user must 
make a tradeoff between measurement time and accuracy when using a lock in amplifier. It will 
take 5 time constants for the reading to settle to 1%, 7 time constant for the reading to settle to 
0.1%. Fluctuations in the signal after this amount of time are not due to the lock in settling time 
but are real signal variations. 
 
The subsequent sections explain in detail how to use the Applications Software to makes 
measurements. 
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7 Using the Applications Software 
 

7.1 The Main Display Panel 
The Main Display Panel has five display regions. They are: 
 
1. The Digital Display which is always visible. 
2. The Strip Chart, which is on a user selectable tab. 
3. The Statistics Display, which is on a user selectable tab. 
4. The Tuning Needles, which are on a user selectable tab. 
5. The Setup Controls, which are on a user selectable tab. 
 

The Digital Display 
The Digital Display is always visible to the user. It contains Controls and Indicators. A control is 
an input to the application set by the user. An indicator is an output from the application for use by 
the user. 
 

 
 
 

Digital Controls 
The Controls on the Digital Display area are: 
 
Data Collection 
Log to File 
Range 
Filter Tau 
Null 
Batch Size 
Reset 
Auto Reset 
Sample Collection 
Collection Mode 
Time Interval 
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Data Collection 
Data Collection Control. When active the data is collected for display if the device is triggered. 
Data Collection is suspended if another control is activated, then resumed when the other control 
is released. This is done to prevent the communications buffers from overflowing. 
 
Do Not disconnect the device when Data Collection is active. 
 

Log to File 
Log data to selected file. if no file is currently open, a prompt will request the file to log data to. 
Data files can be opened, saved, closed and viewed via the File menu. 
 

Range 
Selects the desired device measurement range. 
 

Filter Tau 
Sets the time constant of the low pass filter used in the Lock In Amplifier. 
 

Null 
Subtracts the value of displayed Power or Irradiance when pressed from the subsequent 
measured values. Releasing the control returns to normal measurements. 
 
Note that the total maximum displayed measurement, that is the measured value plus the Nulled 
value, cannot exceed the selected Range when Null is active. 
 

Batch Size 
The Batch Size to collect in Fixed Sample Collection Mode. Resets with the Reset Button or Auto 
Reset. 
 
If the Current Sample exceeds the Batch Size when Fixed Sample Collection is selected, a Reset 
must be issued to start the new batch. 
 

Reset 
The Reset button resets the current data set in all collection modes. 
 

Auto Reset 
Resets the batch when the Current Sample meets the Batch Size if in Fixed Sample Collection 
mode. 
 

Sample Collection 
Sample Collection is: 
 
Continuous. Data is streamed whenever Data Collection is on. Always only withTime Interval Collection 
mode. 
 
Fixed. Data is collected whenever Data Collection is on until the Current Sample meets the Batch 
Size. 
 

Collection Mode 
Collection Mode is: 
 
Streaming. Data is streamed at the data frequency rate. Always only with Fixed Data Sample Collection 
mode. 
 
Time Interval. Data is collected when the selected time interval is met. The Time Interval control 
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is shown when Collection Mode is set to Time Interval. 
 

Time Interval (s) 
The Time Interval to wait between taking a data point. Intervening data points are discarded. 
 

Digital Indicators 
The Indicators on the Digital Display area are: 
 
Live Data 
Rv 
Wavelength (nm) 
Frequency (Hz) 
Frequency Range 
Frequency In Range 
Locked 
Current Sample 
Corrections Active 
 

Live Data 
The Main Display for: 
Power (W) or Irradiance (W/cm

2
) . 

 

Rv 
Responsivity in V/W of the sensor for the selected Range. 
 

Wavelength (nm) 
The wavelength of the light source being measured. Enter this value on the Setup Tab. 
 

Frequency (Hz) 
The frequency of the measured data in Hz. Resolution is 0.1Hz. 
 

Frequency Range 
The allowed range of chopper (Radiometers) frequencies. 
 

Frequency in Range 
Illuminates when the Frequency is within the calibrated range. 
 

Locked 
Illuminates when the device is Locked to the synthesized reference frequency used by the Digital 
Lock In algorithm and Data Collection is active. 
 

Current Sample 
The current sample in the batch. Resets with the Reset Button or and Auto reset in Fixed Sample 
Collection Mode. 
 
If the Current sample exceeds the batch size when Fixed is selected, a Reset must be issued to 
start the new batch. 
 

Corrections Active 
 
Illuminates when Wavelength Corrections or Transmissivity Corrections or Area Corrections are 
active. 
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7.2 The Strip Chart Display 
 
The Strip Chart Display is visible to the user when its tab is selected. It contains Controls and 
Indicators for the Strip Chart. 
 

 
 

Strip Chart Controls 
The Controls on the Strip Chart area are: 
Auto Scale 
There are more Strip Chart Display controls available in the Display Options Menu 
 

Auto Scale 
Auto Scales the Strip Chart Display to the running minimum and maximum values in the data set. 
 

Strip Chart Indicators 
The Indicators on the Strip Chart area are: 
Strip Chart Plot 
 

Strip Chart Plot 
Displays each data point as it is acquired. 
 
In Continuous Mode the plot functions as a strip chart and fills until Data Collection is turned off. 
In Fixed Mode the plot functions as a strip chart and fills until Batch Size is met. On Reset the 
chart clears and refills with the new batch. 
 
Right click on the Data Icon to set the Plot Options. 
Right click on the X-Axis set the X-Axis Options. 
Right click on the Y-Axis set the Y-Axis Options. 
 
Min and Max Tracking Cursors can be set using the Display Options Menu. 
 

The Statistics Display 
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The Statistics Display is visible to the user when its tab is selected. It contains Controls and 
Indicators for the statistics on the data set. 
 

 
 

Statistics Controls 
There is a single control on the Statistics tab; Display as %. 
 

Display as % 
Displays the Std. Dev. as a percentage of the Mean. 
 

Statistics Indicators 
The Indicators on the Statistics tab are: 
 
Min 
Max 
Mean 
Standard Deviation 
Filter Bandwidth 
Data File 
 

Min 
The minimum value of the current data set. Resets with the Reset button or an auto reset when in 
Fixed Sample Collection mode. Updates on each sample. 
 

Max 
The maximum value of the current data set. Resets with the Reset</B> button or an auto reset 
when in Fixed Sample Collection mode. Updates on each sample. 
 

Mean 
The Mean of the current data set. Active in Fixed Sample Collection mode. Updates when the 
Batch Size is met. Resets with the Reset button or an Auto Reset when the Batch Size is met. 
 



T-RAD-LEMO-USB Instruction Manual                            Version 2.0                June 2012 18 

Standard Deviation 
The standard deviation of the data set. This can be interpreted as the RMS noise. 
Standard Deviation and Variance Details: 
 
The VI calculates the output values using the following equations. 
 

n - 1 
µ = SUM [ Xi / n ] 

i = 0 
 
where N is mean and n is the number of elements in X. 
 
standard deviation = Q^2 
 

n - 1 
Q^2 = SUM [ ( Xi - N)^2 /( n - 1) ] 

i = 0 
 
where Q is variance, N is mean. 
 

Filter Bandwidth 
The filter bandwidth that results from the selected filter Tau. 
 

Data File 
The path of the currently open data file. If the indicator is empty, no file is currently open to log 
data. 
 

7.3 The Tuning Needles Display 
 
The Tuning Needles Display is visible to the user when its tab is selected. It contains Controls 
and Indicators for the Tuning Needles. 
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Tuning Needles Controls 
The Controls on the Tuning Needles area are: 
Tuning Scale 
Reset Needles 
 

Tuning Scale 
Use this button to select the scaling range of the tuning meter. 
 
Min - Max: sets the low end of the scale range to the Minimum value in the data set and the high 
end of the scale range to the Maximum value in the data set since the last Reset Needles. 
 
Zero - Max: sets the scale range from Zero to the Maximum of the measurement Range. 
 

Reset Needles 
 
Resets the Minimum and Maximum to the value of Current. 
 

Tuning Needles Indicators 
The Indicators on the Tuning Needles area are: 
Tuning Needles 
Current 
Minimum 
Maximum 
Current Sample 
Data Collection Active 
 

Tuning Needles 
Displays the Maximum (Red Needle), Minimum (Blue Needle) and the Current (Black Needle) 
measured value. Scale Range is set with the Tuning Scale control. 
Minimum and Maximum are reset when Reset Needle is pressed. 
 

Current 
The Current Measured Value. 
 

Minimum 
The Minimum Measured Value. 
 

Maximum 
The Maximum Measured Value. 
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7.4 The Setup Display 
 
The Setup Display is visible to the user when its tab is selected. It contains Controls and 
Indicators for the Setup. 
 

 
 

Setup Controls 
The Controls on the Setup area are: 
 
Wavelength (nm) 
% Transmissivity 
Diameter (Area) 
Entry Type 
Display W/cm^2 
User Serial Number 
User Calibration Date 
Write to Instrument 
Read From Instrument 
Zero Baseline 
Reset Instrument 
 

Wavelength (nm) 
Enter the Wavelength of the light source being measured. 
 
Wavelengths other than the calibration wavelength may result in wavelength corrections being 
applied. If corrections are applied, the Corrections Active LED will illuminate. 
 
To view the wavelength response of the sensor, use the Display menu item. 
 

% Transmissivity 
Enter the Transmissivity of external optics being used. 
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Diameter (mm) or Area (cm
2
) 

Enter the Diameter or the Area, based on the Entry Type, of the light source or external aperture 
being used. 
 

Entry Type 
Change the Diameter control to an Area control. 
 

Display W/cm
2
 

Toggles the data displays from Watts to Irradiance. Uses the Area indicator to compute the 
values. 
 

User Serial Number 
The User Serial Number. Stored in persistent memory 
 

User Calibration Date 
The User Calibration Date. Stored in persistent memory 
 

Write to Instrument 
Writes the User Serial Number and the User Cal Date to the persistent memory of the device. 
 

Read From Instrument 
Reads the User Serial Number and the User Cal Date from the persistent memory of the device. 
 

Setup Indicators 
The Indicators on the Setup area are: 
 
Wavelength Factor 
Transmissivity Factor 
Area (cm

2
) 

T-Rad-USB Serial Number 
T-Rad-USB Calibration Date 
Device ID 
Firmware version 
 

Wavelength Factor 
The correction factor for the current Wavelength. 
 

Transmissivity Factor 
The correction factor for the current Transmissivity. 
 

Area (cm
2
) 

The current Area of the measured beam. 
 

T-Rad-USB Serial Number 
The Factory Serial Number. 
 

T-Rad-USB Calibration date 
The Factory Calibration Date. 

 

Device ID 
The Device ID of the instrument plugged into the USB. 
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Firmware Version 
The Device Internal Firmware Version. 
 

Application Menus 
The T-Rad-USB Application Software has three main menu items, each with its own sub menus. 
They are: 
The File Menu 
The Display Menu 
The Help Menu 
 

The "File" Menu 
The File menu is used to open, close, and view data sets. The menu items are: 
 
Open Data File 
Close Data File 
View Existing Data File 
Print Window 
Exit 
 

Open Data File 
Opens a File too write data to. User is allowed to name a new file or overwrite an old one. 
 

Close Data File 
Closes the currently open data file. 
 

View Existing Data File 
Allows the user to choose an existing data file for viewing with the Data Analysis Panel. 
 

Print Window 
Prints the current window. 
 

Exit 
Exits the Application. Closes all open files and stops the T-Rad-USB data stream. Exit saves the 
state of all Application Controls and restores them on restart. 



T-RAD-LEMO-USB  Instruction Manual                 Version 1.0         June. 2012 23 

 

7.5 The Display Menu 
The Display menu is used to modify the characteristics of the Digital Display and the Strip Chart. 
It also displays the Wavelength Correction Table stored in the sensor. The menu items are: 
Display Options 
View Wavelength Correction Table 
 

Display Options 
Calls new panel that allows the user to set Cursors on the Strip Chart, Cursor Colors, and Cursor 
Range. 
 

 
 
If Auto Track Min/Max is selected, then the Cursors track the min and max values in the data set. 
If User Min/Max is Checked, then User Min and User Max sets the Cursor Range. 
Right click on the Cursor Color Box to display a color palette. 
 

7.6 View Wavelength Correction Table 
 
Calls new panel that allows the user to View the Sensor Wavelength Correction Curve. 
 

 
 



T-RAD-LEMO-USB Instruction Manual                            Version 2.0                June 2012 24 

7.7 The Help Menu 
The Help menu is used to display help for the Application. The menu items are: 
Help 
Show Context Help 
About 
 

Help 
Calls this Help file. 

 

Show Context Help 
Shows a Context Sensitive Help Window when the Mouse Cursor is over a Control or Indicator. 
 

About 
Application Information is Displayed. 

 



T-RAD-LEMO-USB  Instruction Manual                 Version 1.0         June. 2012 25 

8 DECLARATION OF CONFORMITY 
  

Application of Council Directive(s): 2004/108/EC EMC Directive 
       
 Manufacturer’s Name:   Gentec Electro Optics, Inc. 
 Manufacturer’s Address:  445 St-Jean Baptiste, suite 160 

(Québec), Canada   G2E 5N7 
 
 Representative’s Name:   Laser Component S.A.S 
 Representative’s Address:  45 bis Route des Gardes 
      92190 Meudon (France) 
 
 Type of Equipment:   Laser Power/Energy Meter 
 Model No.:    T-RAD 
 Year of test & manufacture:  2011 
 

Standard(s) to which Conformity is declared:    
EN 61326-1: 2006 Emission generic standard 

 
Standard Description Performance 

Criteria 

CISPR 11 :2009    
+A1 2010  

Industrial, scientific and medical equipment – Radio-
frequency disturbance characteristics – Limits and 
methods of measurement 

Class A 

EN 61000-4-2:2009 
 

Electromagnetic compatibility (EMC) – Part 4-2: Testing 
and measurement techniques- Electrostatic discharge. 

Class B 

EN 61000-4-3:2006 
+A2:2010 
 

Electromagnetic compatibility (EMC) – Part 4-3: Testing 
and measurement techniques- Radiated, Radio 
Frequency, electromagnetic field immunity test. 

Class A 

 
 

I, the undersigned, hereby declare that the equipment specified above 
conforms to the above Directive(s) and Standard(s) 

 
 

Place:  Québec (Québec)    
 Date : June 11, 2012   

  
 (President) 
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